
HIGH SCHOOL | NEWSLETTER
H

December 18 - December 22, 2023

ANNOUNCEMENTS
QURAN AND HADEETH COMPETITION CELEBRATION
Thursday, December 21
The Quran and Hadeeth Competition Celebration for High School will be on Thursday, December 21st at
11:00AM in the ARCA Banquet Hall. Invitations have been emailed to the winners’ parents/guardians.

POST SECONDARY SCHOLARSHIP INFORMATION
Information available on the link below
Mr. Chang gave an excellent presentation outlining the various scholarship opportunities available for
post secondary study!! All the information is available on the link below:
PPTX: Scholarships 21-22.pptx
Zoom recording: https://youtu.be/FhyH4wwFfRM

UNIFORM POLICY
High School Girls:
High School girls are to wear any black abaya and a hijab (any color).

High School Boys:
Monday thru Thursday, High School boys are to wear a pair of black school pants and a green school
polo shirt (short or long-sleeve). On Fridays, boys are to wear a pair of black school pants and any dress
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shirt with any tie or a thobe or similar form of cultural clothing. If boys wish to wear an extra Layer, a
hoodie with school or legends logo is permitted.

High School Sweaters:
Only school hoodies with the school logo, or hoodies that are completely black (no
writing/pictures/brand names visible) are allowed for all high school students.

Purchasing a Uniform
Uniform Fittings for students are held at EIA several times throughout the year when McCarthy
Uniforms comes to EIA. If a fitting is not required, a parent may purchase any piece of a uniform by
ordering online through the website https://www.mccarthyuniforms.ca

HIGH SCHOOL INFORMATION BOOKLET
The following is the link:
https://www.islamicacademy.ca/download/424951

FINAL EXAM SCHEDULE
Located at the end of this Weekly Newsletter.

CLUBS
STUDENT INVOLVEMENT CLUB
The Student Involvement Club is aimed at focusing on global, community, and school issues and what
role students can play in working on resolving these issues. The Student Involvement Club plans to host
various presentations on issues ranging from environmental issues to the importance of mental health.
If you would like to contribute to or join the Student Involvement Club, please join the club Remind at
SICEIA. For more information, please contact Ms. Zahoui via email at kassia.zahoui@islamicacademy.ca

STUDENT ACTIVITY CLUB
The Student Activity Club (SAC) is student-run, focused on organizing entertaining out-of-school
activities and field trips for all high school students. Previous field trips included Corn Maze, Laser Tag,
Bowling, along with activities such as movie night at the school. Join SAC to create fun opportunities
with your classmates! Club meetings are on Tuesdays at lunch with Mr. Smith and Ms. Jude. For more
information, contact Mr. Smith (douglas.smith@islamicacademy.ca) or Ms. Jude
(jude.alnajdawi@islamicacademy.ca).

ATHLETICS
You are now able to view upcoming High School games and practice times using this link, and receive
weekly updates by joining the High School Athletics remind page using the code eiaathl
Please see the end of the newsletter for the High School games schedule.
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CORE CLASSES
UPCOMING ASSESSMENTS

MATHEMATICS 30-1
Hussein Akeileh // hussein.akeileh@islamicacademy.ca

TOPICS
➔ Chapter 11 : Permutations, Combinations and the Binomial Theorem

IMPORTANT DATES
❖ Wednesday, December 20: Exponents & LOGS test ( Part 2 )

RESOURCES
★ All resources are available on GoogleClassroom code: 22bhynp
★ Workbook available on Annotate.net through Google classroom invitation.
★ Remind code: @eiamath30x/y/z for Blocks 1/2/3 respectively

BIOLOGY 30
Jude Alnajdawi // jude.alnajdawi@islamicacademy.ca

TOPICS
➔ Diploma Prep

IMPORTANT DATES
❖ Tuesday, December 19: Unit D Test
❖ Friday, December 22: Bunny Population Assignment

RESOURCES
★ Nelson Textbook
★ Google Classroom code: fma44wk
★ Remind Code: bio30ja

CHEMISTRY 30
Rim Moussa // rim.moussa@islamicacademy.ca

TOPICS
➔ pH Curves and Indicators
➔ Buffer Systems

IMPORTANT DATES
❖ Friday, December 22: Chapter 16 Test
❖ Tuesday, January 9: Unit D Exam

RESOURCES
★ Please bring your note package and lab manual with you everyday.
★ All resources can be accessed on GoogleClassroom.
★ Nelson Textbook.
★ Remind code: @chem30-

PHYSICS 30
Michael Whipple // michael.whipple@islamicacademy.ca

TOPICS
➔ Standard Model
➔ Quarks
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IMPORTANT DATES
❖ Tuesday, December 19: Ch. 16-17 Test
❖ Thursday, December 21: Unit D Test

RESOURCES
★ Whipplephys.com
★ Remind Code (Block 3): @eiaphys303
★ Castle Rock - Class Notes - Physics 30 (can be obtained from High School Office)

ENGLISH 30-1
Dalyah Mouallem // dalyah.mouallem@islamicacademy.ca

TOPICS
➔ Wrap up Film Unit
➔ Diploma prep and writing workshops

IMPORTANT DATES
❖ Wednesday, December 20 (tentative): Reading Comprehension Exam
❖ Friday, December 22: Field Test

RESOURCES
★ Google Classroom → Block 1: xumt6qc; Block 3: dtja7cr
★ Remind code: @ela30eia
★ Commonlit class code: 7Y6DP4W

SOCIAL STUDIES 30-1
Mohamed Dahrouge // mohamed.dahrouge@islamicacademy.ca

TOPICS
➔ Challenges to Liberalism

IMPORTANT DATES
❖ Wednesday, December 20: Related Issue 3 Exam
❖ Friday, December 22: Field Test (optional)

RESOURCES
★ Google Classroom: : cpelkee
★ Remind: @soc30eia

BIOLOGY 20
Jude Alnajdawi // jude.alnajdawi@islamicacademy.ca

TOPICS
➔ Unit A: Interactions within the Biosphere

IMPORTANT DATES
❖ Tuesday, December 19: Unit D Test
❖ Thursday, December 21: Unit A Test
❖ Tuesday, January 9: Unit D Project

RESOURCES
★ Nelson Textbook
★ Google Classroom Code: pdiksyn
★ Remind Code: @bio20ja

CHEMISTRY 20
Ghofrane Ben Mabrouk // ghofrane.benmabrouk@islamicacademy.ca

TOPICS: Review
➔ Unit D Exam and Course Review
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IMPORTANT DATES
❖ Tuesday, December 19: Unit D Exam

RESOURCES
★ Nelson Textbook
★ EIA Workbook and Lab Manual
★ Google Classroom Code: rtr4m7j
★ Remind Code: @24kgf7d

PHYSICS 20
Michael Whipple // michael.whipple@islamicacademy.ca

TOPICS
➔ Unit D Review

IMPORTANT DATES
❖ Monday, December 18: Ch. 8 Test
❖ Thursday, December 21: Unit D Test

RESOURCES
★ Whipplephys.com
★ Remind Code (Block 1): @eiaphys201
★ Remind Code (Block 2): @eiaphys202
★ Castle Rock - Class Notes - Physics 20 (can be obtained from High School Office)

ENGLISH 20-1
Dalyah Mouallem // dalyah.mouallem@islamicacademy.ca

TOPICS
➔ Wrap up Film Study
➔ Final exam prep

IMPORTANT DATES
❖ Thursday, December 21 (tentative): Reading Comprehension exam

RESOURCES
★ Google Classroom: sk6byhu
★ Remind code: @ela20eia
★ Commonlit class code: 7Y6DP4W

SOCIAL STUDIES 20-1
Doug Smith // douglas.smith@islamicacademy.ca

TOPICS
➔ What is internationalism
➔ Challenges to internationalism

IMPORTANT DATES
❖ Wednesday, December 21: Mock Final

RESOURCES
★ Textbook: Exploring Nationalism
★ Google Classroom: k5vyaxf
★ Remind: kbfh2d

SOCIAL STUDIES 20-1
Mohamed Dahrouge // mohamed.dahrouge@islamicacademy.ca

TOPICS
➔ Related Issue 3: Internationalism

IMPORTANT DATES
❖ Thursday, December 21: Related Issue 3 Exam (35 Questions)
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RESOURCES
★ Google Classroom: bv5tvsm
★ Remind: @soc20eia

SCIENCE 10
Sajeda Tarabain // sajeda.tarabain@islamicacademy.ca

TOPICS: CLIMATE
➔ Human impact on climate
➔ Natural vs. Enhanced Greenhouse Effect
➔ Carbon sinks and Greenhouse Gases

IMPORTANT DATES
❖ Monday, December 18: Chapter 12 Quiz
❖ Tuesday, December 19: Biome Research Project due
❖ Wednesday, December 20: Climate Unit Exam

RESOURCES
★ Google Class Code: g2pc2xo
★ Remind: @scieia10
★ Science Focus 10
★ EIA Workbook and Lab Manual

SCIENCE 10
Ghofrane Ben Mabrouk // ghofrane.benmabrouk@islamicacademy.ca

TOPICS: Physics
➔ Human impact on climate
➔ Natural vs Enhanced Greenhouse Effects
➔ Carbon sinks and Greenhouse gasses

IMPORTANT DATES
❖ Monday, December 18: Chapter 12 Quiz
❖ Tuesday, December 19: Biome Research Project due
❖ Wednesday, December 20: Climate Unit Exam

RESOURCES
★ Google Class Code: 4xspckc
★ Remind: @c4ee4a
★ Science Focus 10
★ EIA Workbook and Lab Manual

MATH 10C
Ehab Abou-Absi // ehab.abou-absi@islamicacademy.ca

TOPICS
➔ Generate systems of linear equations and create graphs to model situations.
➔ Solve two-variables systems of linear equations graphically and algebraically (by substitution

and elimination methods).
➔ Verify solutions to two-variable systems of linear equations.
➔ Explain why systems of linear equations may have zero, one, or an infinite number of solutions.
➔ Solve real-life examples involving two-variables systems of linear equations.

IMPORTANT DATES
❖ Tuesday, December 19: Unit 3 Exam
❖ Thursday, December 21: Chapters 8 and 9 Test
❖ Tuesday, January 9: Unit 4 Exam
❖ Thursday, January 18: Math 10C Final Exam

RESOURCES
★ AVP iWrite Math 10 Pre-Calculus Mathematics Book
★ Remind Code Block 1: @math10blk1
★ Remind Code Block 2: @math10blk2
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★ Remind Code Block 3: @math10blk3
★ Google Classroom Code Block 1: vr77s3y
★ Google Classroom Code Block 2: dmmju2f
★ Google Classroom Code Block 3: sk6lsuu

MATH 10C
Mostafa Mahfouz // mostafa.mahfouz@islamicacademy.ca

TOPICS
➔ Generate systems of linear equations and create graphs to model situations.
➔ Solve two-variables systems of linear equations graphically and algebraically (by substitution

and elimination methods).
➔ Verify solutions to two-variable systems of linear equations.
➔ Explain why systems of linear equations may have zero, one, or an infinite number of solutions.
➔ Solve real-life examples involving two-variables systems of linear equations.

IMPORTANT DATES
❖ Tuesday, December 19: Unit 3 Exam
❖ Thursday, December 21: Chapters 8 and 9 Test
❖ Tuesday, January 9: Unit 4 Exam
❖ Thursday, January 18: Math 10C Final Exam

RESOURCES
★ AVP iWrite Math 10 Pre-Calculus Mathematics Book
★ Remind Code: @mahfouz10
★ Google Classroom Code Block 1: wm6zsy3

SOCIAL STUDIES 10-1
Doug Smith//douglas.smith@islamicacademy.ca

TOPICS
➔ To what extent should we embrace globalization

IMPORTANT DATES
❖ Monday, December 18: Projects Due
❖ Wednesday, December 20: Mock Final

RESOURCES
★ Textbook: Exploring Globalization
★ Google Classroom: en7nwfj
★ Remind: e3fe943

SOCIAL STUDIES 10-1
Kassia Zahoui // kassia.zahoui@islamicacademy.ca

TOPICS
➔ Unit 4: To what extent should I, as a citizen, embrace globalization?

IMPORTANT DATES
❖ Monday, December 18: Unit 3 Exam
❖ Friday, December 22: Unit 4 Writing Assignment

RESOURCES
★ Textbook: Exploring Globalization
★ Google Classroom: mywbjqk
★ Remind: ss10zahoui

ARABIC 15, 25, 35
Raghda Abdelqader // raghda.abdelqader@islamicacademy.ca

TOPICS:
➔ Continue the lesson “ الطبيبنصائح ”
➔ General revision.
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IMPORTANT DATE
❖ None

RESOURCES
★ السابعالمستوى-العربيةاللغةحديقةفي
★ Remind:@raghdahs
★ Google classroom code: hgzewrg

ISLAMIC ETHICS (Grade 10)
Imran Qureshi // imran.qureshi@islamicacademy.ca

TOPICS:
➔ Tafseer Surah Al-Fatiha
➔ Iyyaka Na’abudu - meaning of Ibadah

IMPORTANT DATES
❖ Week of December 18: Students must complete their projects or attempt the exam

RESOURCES
★ Google Classroom: 4yk3wdi

ISLAMIC INTERACTIONS (Grade 11)
Imran Qureshi // imran.qureshi@islamicacademy.ca

TOPICS:
➔ Fiqh of inheritance

IMPORTANT DATES
❖ Thursday, December 21: Test on Inheritance calculation

RESOURCES
★ https://sites.google.com/islamicacademy.ca/hsis/jurisprudence-of-interaction

★ Google Class Code:

ISLAMIC THOUGHT (Grade 12)
Imran Qureshi // imran.qureshi@islamicacademy.ca

TOPICS:
➔ Fiqh of Priorities

IMPORTANT DATES
❖ Wednesday, December 20: Test or Project

RESOURCES
★ Google Class Code: l5gk4vt

ISLAMIC STUDIES (Grade 11)
Fatima Bensassi // Fatima.binsassi@islamicacademy.ca

TOPICS:
➔ Final Exam

IMPORTANT DATES
❖ Thursday, December 21: Final exam

RESOURCES
★ Google Classroom: jushmwd

ISLAMIC STUDIES (Grade 12)
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Fatima Bensassi // Fatima.binsassi@islamicacademy.ca

TOPICS:
➔ Final Exam

IMPORTANT DATES
❖ Friday, December 22: Final exam

RESOURCES
★ Google Classroom

ISLAMIC INTERACTIONS (Grade 11)
Warda Nadjai // warda.nadjai@islamicacademy.ca

TOPICS:
➔ Final exam

IMPORTANT DATES:
❖ Thursday, December 21: Final exam

RESOURCES
★ Google class code: d6mzx5c
★ Remind: @h3h9hc

ISLAMIC INTERACTIONS (Grade 12)
Warda Nadjai // warda.nadjai@islamicacademy.ca

TOPICS:
➔ Final exam

IMPORTANT DATES
❖ Tuesday, December 19: Final exam

RESOURCES
★ Google class code: 4px7bwe
★ Remind: @adc666

ART 10, 20, 30
Christelle Agahozo // christelle.agahozo@islamicacademy.ca

TOPICS
➔ Art 10: Students are glazing their mugs and working on their landscape painting.
➔ Art 20: Students are glazing their bowls and finishing their pen and ink drawing of a mosque.
➔ Art 30: Students are glazing their vases working with oil painting of a mini painting study.

IMPORTANT DATES
❖ None

RESOURCES
★ Google Classroom

CALM 20 (BOYS)
Hussein Akeileh // hussein.akeileh@islamicacademy.ca

TOPICS
➔ Resume building

IMPORTANT DATES
❖ None

RESOURCES
★ Google Classroom Code: ypyehy7
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★ Remind code: @eiacalm20

CALM 20 (GIRLS)
Sajeda Tarabain // sajeda.tarabain@islamicacademy.ca

TOPICS
➔ Resume building

IMPORTANT DATES
❖ Thursday, December 21: Resume Due

RESOURCES
★ Google Classroom Code: mbs745o
★ Remind Code: @calm20eia

PHYSICAL EDUCATION 10, 20, 30 GIRLS
Shanya Shwetz //shanya.shwetz@islamicacademy.ca

TOPICS
➔ Combining Cardiovascular health with sport
➔ Beep Test
➔ Kickball

◆ Positioning
◆ Team Play
◆ Kicking
◆ Catching
◆ Passing

IMPORTANT DATES
❖ None

PHYSICAL EDUCATION 10, 20, 30 BOYS
Yahia Dalloul : Yahia.dalloul@islamicacademy.ca

TOPICS
➔ students develop the necessary skills and knowledge to pursue badminton as a lifetime activity.

Also students with opportunities to improve physical fitness, acquire knowledge of fitness
concepts and practice positive personal and social skills. Students will gain an understanding of
how a wellness lifestyle affects one’s health, fitness and physical performance.

IMPORTANT DATES
❖ None

FOODS
Mohamed Dahrouge // mohamed.dahrouge@islamicacademy.ca

TOPICS:
➔ Farm to Table

IMPORTANT DATES
❖ Thursday, December 21: Final Cook-Off

RESOURCES
★ Google classroom code: gzvbodv

BUSINESS MANAGEMENT
Billal Hajji // billal.hajji@islamicacademy.ca

TOPICS
➔ Exploring the Insides and Outsides of Marketing
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IMPORTANT DATES
❖ None

RESOURCES
★ Google Classroom: rolxwp3
★ Remind: @h93cbb
★ Chromebooks/Laptops

COMPUTER SCIENCE
Isaiah Ling // isaiah.ling@islamicacademy.ca

TOPICS
➔ Computer Science 10 will work on their CSE Project A
➔ Computer Science 20 will work on their CSE Project C
➔ Computer Science 30 will work on their CSE Project D

IMPORTANT DATES
❖ Tuesday, January 8: Final Project presentation (All sections)

RESOURCES
★ Computer Science 10

○ Google Classroom: ko3irs4
○ Codehs: 29BD4
○ Remind: lingcs10

★ Computer Science 20
○ Google Classroom: dtpqyqw
○ Codehs: 0FE1B
○ Remind: lingcs20

★ Computer Science 30
○ Google Classroom: ko3irs4
○ Codehs: 751F9
○ Remind: lingcs30
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High School Timetable – 2023/2024

Block
Mon, Tues &

Wed

Block/Summer
Thursday

Block/Winter
Thursday

Block/Summer
Friday

Block/Winter
Friday

B1
8:30 – 9:56
86 min

B1
8:30 – 9:40
70 min

B1
8:30 – 9:40
70 min

B1
8:30 – 9:56
86 min

B1
8:30 – 9:56
86 min

9:56 – 10:00
4 min

9:40 – 9:44
4 min

9:40 – 9:43
3 min

9:56 – 10:00
4 min

9:56 – 9:59
3 min

B2
10:00 – 11:26

86 min

B2
9:44 – 10:54

70 min

B2
9:43 – 10:53

70 min

B2
10:00 – 11:26

86 min

B2
9:59 – 11:25

86 min

Lunch break
11:26 – 12:10

44 min

10:54 – 10:58
4 min

10:53 – 10:56
3 min

Lunch break
11:26 – 12:10

44 min

Lunch break
11:25 – 12:05

40 min
B3

10:58 – 12:08
70 min

B3
10:56 – 12:06

70 min

B3
12:10 – 1:36

86 min

Lunch break
12:08 – 12:50

42 min

Lunch break
12:06 – 12:36

30 min

B3
12:10 – 1:36

86 min

B3
12:05 – 12:50

45 min

Prayer
12:36 – 12:50

14 min

Prayer
1:36 – 2:04
28 min

B4
12:50 – 2:00

70 min

B4
12:50 – 2:00

70 min

Jumu’ah Prayer
1:36 – 2:04
26 min

Jumu’ah Prayer
12:50 – 1:20

30 min

B4
2:04 – 3:30
86 min

Early Dismissal Early Dismissal B4
2:04 – 3:30
86 min

B3 Continued
1:20 – 2:01
41 min

2:01 – 2:04
3 min

B4
2:04 – 3:30 (86 min)
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Diploma and Final Exams Schedule 2023-2024

Semester 1

Date Day Exam Number of
Students

Room Supervisor Time

January 10th Wed.
English 30-1

part A (Writing) 30 STEAM
Ms. Christelle 9:00 am–12:00pm

Mr. Ling 12:00 pm–3:00pm

January 10th Wed.
English 20-1

part B (reading comprehension)
23 70 Ms. Dalyah 9:00 am–12:00pm

January 10th Wed.
Social 20-1

part A (Writing)
B2: 20 273 Mr. Dahrouge

9:00 am–12:00pm
B4: 22 274 Mr. Smith

January 11th Thurs.
Social 30-1

part A (Writing) 17 STEAM
Ms. Christelle 9:00 am–12:00pm

Mr. Ling 12:00 pm–3:00pm

January 11th Thurs.
Social 20-1

part B (reading comprehension)
B2: 20 273 Mr. Dahrouge

9:00 am–12:00pm
B4: 22 274 Mr. Smith

January 11th Thurs.
English 20-1

part A (Writing)
23 70 Ms. Dalyah 9:00 am–12:00pm

January 12th Fri. Arabic 12 72 Ms. Fatima 9:00 am–12:00pm

January 15th Mon.
Social 10-1

part A (Writing)
94 ARCA

Mr. Smith
Ms. Zahoui

Ms. Ghofrane
9:00 am–12:00pm

January 16th Tues.
Social 10-1

part B (reading comprehension)
94 ARCA

Mr. Smith
Ms. Zahoui
Ms. Rim

9:00 am–12:00pm

January 17th Wed. No Exam

January 18th Thurs. Math 10C 91 ARCA
Mr. Abou-Absi
Mr. Dahrouge

Ms. Rim
9:00 am–12:00pm

January 19th Fri. No Exam

January 22nd Mon. Math 30-1 70 ARCA

Ms. Ghofrane
Mr. Whipple

9:00am–12:00pm

Mr. Abou-Absi
Ms. Jude

12:00pm–3:00pm

January 23rd Tues.
English 30-1

part B (reading
comprehension)

30 ARCA
Mr. Whipple 9:00am–12:00pm

Mr. Akeileh 12:00pm–3:00pm

January 24th Wed.
Social 30-1

part B (reading
comprehension)

17 277
Mr. Akeileh 9:00am–12:00pm

Ms. Christelle 12:00pm–3:00pm

January 25th Thurs. Biology 30

B2: 17 277 Mr. Akeileh
9:00am–12:00pm

B1: 13 272 Mr. Whipple

B2: 17 277 Br. Imran
12:00pm–3:00pm

B1: 13 272 Mr. Ling

January 25th Thurs. Biology 20 26
ARCA

Ms. Jude
Ms. Sajeda
Ms. Ghofrane

9:00am–12:00pm
January 25th Thurs. Science 10 84

January 26th Fri. Chemistry 30 25 271
Mr. Abou-Absi 9:00 am–12:00pm

Mr. Ling 12:00pm–3:00pm

January 26th Fri. Chemistry 20
B1: 18 72 Ms. Fatima

9:00 am–12:00pm
B2: 12 71 Ms. Sajeda

January 29th Mon. Physics 30 7 275
Ms. Rim 9:00 am–12:00pm
Ms. Jude 12:00pm–3:00pm

January 29th Mon. Physics 20
20 71 Ms. Sajeda

9:00 am–12:00pm
18 70 Ms. Dalyah

January 30th Tues. Report Card 4:00pm

January 31st Wed. Semester 2 Begins
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